EMP Monitor V4.22
Operation Guide

Meanings of symbols used
The following table shows the symbols used in this manual, along with descriptions of what they mean.
CAUTION

TIP

Indicates something that may cause injury or damage to the projector.
Indicates information that is related to a topic or which may be useful to know.
Indicates a page where a related topic or a more detailed explanation is provided. Click on the page
number to display that page.

[ (Name) ]

Indicates the name of a projector port or a computer menu or item name.
Example: [InputA] [Start]
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Tasks that can be done using EMP Monitor
EMP Monitor lets you carry out operations such as checking the statuses of
multiple EPSON projectors that are connected to a network at a computer
monitor, and controlling the projectors from the computer.
Following are brief descriptions of the monitoring and control functions that
can be carried out using EMP Monitor.
• Registering projectors for monitoring and control
- Projectors on the network can be searched for automatically, and you can
then select projectors to be registered from the projectors that are detected.
- You can enter the IP addresses for target projectors to register them.
• Registered projectors can also be assigned to groups so that they
can be monitored and controlled in groups
• Monitoring the statuses of registered projectors
- The power status (ON/OFF) for projectors and problems or warnings
requiring attention can be checked visually by means of icons.
- You can select groups of projectors or a single projector that you are
interested in, and then check the cumulative lamp operating time or the
details of information such as input sources, problems, and warnings for
these projectors.
• Controlling registered projectors
- Projectors can be selected in groups or as single projectors, and you can
then carry out operations for the selected projectors such as turning the
power on and off and switching their input sources.
- Web control functions can be used to change the settings in the projector's
configuration menu.
- If there are certain control actions which are carried out regularly at
particular times or on particular days, you can use "Timer Settings" to
register timer settings.
• E-mail notification function settings
You can set e-mail addresses to which notifications are sent if a status
requiring attention, such as a problem, occurs with a projector that has been
registered.

4

Group A
I want to turn on the
power for Group A
projectors.

Projector A

Group B
Projector B

EMP Monitor

System configuration example

TIP

To enable projectors to be monitored and controlled even when they
are in standby mode*, make the following settings at the projectors.
The settings that need to be made will vary depending on the projector
you are using. See your User’s Guide for more information.
• Set "Network Monitoring" to "ON".
• Set "Standby Mode" to "Network ON".
* When the projector's

(Power) indicator is lit orange

Operating environment
Compatible computers
Macintosh computers are not supported.
OS

CPU

Windows 98 Second Edition SP1
Windows Me
Windows NT4.0 SP6
Windows 2000 Professional SP4
The following 32-bit operating systems:
Windows XP Home Edition SP1 or later
Windows XP Professional SP1 or later
Windows Vista Home Basic
Windows Vista Home Premium
Windows Vista Business
Windows Vista Ultimate
Windows Vista Enterprise
• Internet Explorer Ver. 5.0 or later must be installed.
Pentium MMX 166 MHz or higher (Pentium II 233 MHz
or higher recommended)
64 MB or more (128 MB or more recommended)

Memory
capacity
Free hard disk 50 MB or more
space
Display
SVGA (800×600) or higher resolution, 32 bit or higher
display colour

* Operations carried out at the computer may become slow depending on the
number of projectors being managed. If this happens, use a computer with
higher specifications.
* EMP Monitor cannot be used in environments which do not allow pings to
be transmitted.
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Installing EMP Monitor
When you are using Windows 2000/Windows NT4.0/Windows XP/
Windows Vista, you must have administrator authority in order to install
EMP Monitor.
When the language selected for the EMP Monitor installation varies from
that of the OS being used, the EMP Monitor screens may not be displayed
correctly.

PROCEDURE

1

Turn the computer on.
To prevent problems from occurring during the installation, we
recommend that you terminate all resident applications that can
be ended.

2

Load the following CD-ROM in your computer:
"EPSON Projector Software for Monitoring" or
"Epson Projector Software for Meeting &
Presentation".
The installer automatically starts up.

3

From here, continue with the installation by following
the on-screen messages.

Operating environment

Limitations imposed by a Windows Vista
environment
When using EMP Monitor under Windows Vista, note the following
limitations.
• You must have administrator authority in order to use "Register at
startup" on the "Environment setup" screen of EMP monitor.
s"Monitoring using the system tray" p.22
• Even after EMP monitor has been uninstalled, the settings and log
information will remain on the hard disk. If this information is no longer
required, you may delete the "EMP Monitor V4.22" folder. Provided the
default settings were used at installation, this folder can be found at:
"C:\Users\(User Name)\AppData\Local\VirtualStore\Program
Files\EPSON Projector\EMP Monitor V4.22"

Before starting operations
Check the following points before starting up EMP Monitor.
• EMP Monitor must be installed on the computer to be used for
monitoring and control.
• The computer and the projectors must be connected to the network.
• If using Windows 2000, Windows NT4.0, Windows XP, or Windows
Vista, the computer must be started up in Administrator mode.
• For some projectors, a commercially-available serial ⇔ TCP/IP
conversion adapter and a connection cable are required in order to use
EMP Monitor.
• If you are using a serial ⇔ TCP/IP conversion adapter, make the settings
for the adapter before connecting to the projector.
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Registering and deleting projectors for monitoring
This operation is carried out when starting EMP Monitor for the first time after
it has been installed and when you would like to add projectors. Once a
projector has been registered, the status for the projector will be displayed
automatically each time EMP Monitor is started from that point onwards.

Starting EMP Monitor
PROCEDURE

1

Click [Start] - [Programs] (or [All Programs]) - [EPSON
Projector] - [EMP Monitor V4.22] in that order to start
EMP Monitor.

2

The main window will be displayed.
"Grouping view"
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The operations to register projectors using the automatic search will
vary depending on where the projectors are connected to in the
network.
• When registering a projector that is located in the same segment
that the computer the EMP Monitor is installed in is associated
with. s"Registering projectors using automatic search (Searching
for and registering projectors that are located in the same segment)"
p.8
• When registering projectors that are in multiple segments of the
network s"Setting the range of addresses to do an automatic
search and registration" p.10
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Registering projectors using automatic search
(Searching for and registering projectors that are
located in the same segment)

2

Click [Search].
Automatic search will be carried out, and the names of the
projectors that have been detected will be displayed.
• If a projector does not appear in the list, use "Registration by
specifying an IP address (Manual registration)". sp.12

PROCEDURE

f Procedures for automatic search

1

Right-click in "Grouping view" and select "New" "Projector (automatic search)".
The "Create new projector (automatic registration)" window
will be displayed.
• If "Detail list view" is displayed, select "New" - "Projector
(automatic search)" from the "Edit" menu.

TIP

• You can also carry out this operation by selecting "Projector
(automatic search)" from "New" in the "Edit" menu.
• Projectors that are using a serial ⇔ TCP/IP conversion adapter
cannot be detected.
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f Procedures for registration

3

Projector
name
IP address
Use Serial ⇔
TCP/IP
conversion
adaptor.
Port Number

Select the projector(s) to be registered, and then click
[Edit].
The following window will be displayed.
Make the necessary settings while referring to the following
table.

Monitor
Password

Description

Monitor

4

Display name

Display icon
Parent group

Enter the name of the projector(s) to be displayed in
"Grouping view" or "Detail list view".
Up to a maximum of 32 bytes can be entered.
A space cannot be used as the first character.
Select the icon(s) to be displayed in "Grouping view"
or "Detail list view".
Select when registering a projector in a group.
If no groups have been created, this cannot be
selected. s"Registering several projectors to a
monitoring group all at once" p.13

This shows the name that has been registered on the
projector.
This shows the IP address for the registered projector.
This cannot be selected when registering projectors
using automatic search.

This cannot be selected when registering projectors
using automatic search.
If a Monitor Password has been set for the projector,
be sure to enter the Monitor Password that has been
set. If the correct password is not entered at this time,
it will not be possible to monitor and control the
projector even though it is registered.
You can enter some kind of memo about the projector.
The details you enter here will be displayed at the
projector properties.
Up to a maximum of 60 bytes can be entered.
Select this when you want monitoring to start.

After entering the details, click [Register] to start the
registration. When the message is displayed, click
[OK].
To continue registering other projector(s), repeat Steps 3 and 4.
TIP

Projectors that have been registered using automatic search are
searched for again by projector name each time EMP Monitor is
started.
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Registering and deleting projectors for monitoring

5

To end the registration operation, click the
in the
top-right corner of the window or click [Cancel].
The icon(s) of the projector(s) you registered will be displayed
in "Grouping view" or "Detail list view".
Refer to "Monitoring window layout" for details on using the
"Grouping view" and "Detail list view". sp.17

2

Select the "Specify an address range and search"
check box and then enter the starting address and
ending address in the range.

3

Click [Search].
Automatic searching will be carried out, and the names of the
projectors that have been detected will be displayed.

Setting the range of addresses to do an automatic
search and registration
TIP

Projectors that are using a serial ⇔ TCP/IP conversion adapter
cannot be detected.

PROCEDURE

f Procedures for automatic search

1

Right-click in "Grouping view" and select "New" "Projector (automatic search)".
The "Create new projector (automatic registration)" window
will be displayed.
• If "Detail list view" is displayed, select "New" - "Projector
(automatic search)" from the "Edit" menu.
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f Procedures for registration

4

Projector
name
IP address
Use Serial⇔
TCP/IP
conversion
adaptor.
Port Number

Select the projector(s) to be registered, and then click
[Edit].
The following window will be displayed.
Make the necessary settings while referring to the following
table.

Monitor
Password

Description

Monitor

Display name

Display icon
Parent group

Enter the name of the projector(s) to be displayed in
"Grouping view" or "Detail list view".
Up to a maximum of 32 bytes can be entered.
A space cannot be used as the first character.
Select the icon(s) to be displayed in "Grouping view"
or "Detail list view".
Select when registering a projector in a group.
If no groups have been created, this cannot be
selected. s"Registering several projectors to a
monitoring group all at once" p.13

This shows the name that has been registered on the
projector.
This shows the IP address for the registered projector.
This cannot be selected when registering projectors
using automatic search.

This cannot be selected when registering projectors
using automatic search.
If a Monitor Password has been set for the projector,
be sure to enter the Monitor Password that has been
set. If the correct password is not entered at this time,
it will not be possible to monitor and control the
projector even though it is registered.
You can enter some kind of memo about the projector.
The details you enter here will be displayed at the
projector properties.
Up to a maximum of 60 bytes can be entered.
Select this when you want monitoring to start.

5

After entering the details, click [Register] to start the
registration. When the message is displayed, click
[OK].
To continue registering other projector(s), repeat Steps 4 and 5.

6

To end the registration operation, click
in the topright corner of the window or click [Cancel].
The icon(s) of the projector(s) you registered will be displayed
in "Grouping view" or "Detail list view".
Refer to "Monitoring window layout" for details on using the
"Grouping view" and "Detail list view". sp.17
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Registration by specifying an IP address (Manual
registration)

2

• If using a serial ⇔ TCP/IP conversion adapter and cable to connect
the projector, select "Use Serial ⇔ TCP/IP conversion adaptor".
Enter the port number in "Port Number" and then click [Search].

PROCEDURE

1

Right-click in "Grouping view" and select "New" "Projector (manual registration)".
The following window will be displayed.
• If "Detail list view" is displayed, select "New" - "Projector (manual
registration)" from the "Edit" menu.

Enter the IP address of the projector to be registered
in the "IP address" box and then click [Search]. When
the message is displayed, click [OK].

3

After searching is complete, enter the information for
the projector to be registered while referring to the
table below.
Display name

Display icon
Parent group

Projector
name
IP address
Use Serial ⇔
TCP/IP
conversion
adaptor.
Port Number

TIP

You can also carry out this operation by selecting "Projector (manual
registration)" from "New" in the "Edit" menu.

Enter the name of the projector(s) to be displayed in
"Grouping view" or "Detail list view".
Up to a maximum of 32 bytes can be entered.
A space cannot be used as the first character.
Select the icon(s) to be displayed in "Grouping view"
or "Detail list view".
Select when registering a projector in a group.
If no groups have been created, this cannot be
selected. s"Registering several projectors to a
monitoring group all at once" p.13
This shows the name that has been registered on the
projector.
This shows the IP address that you entered in step 2.
Select this if using a serial ⇔ TCP/IP conversion
adapter to connect the projector.
If using a serial ⇔ TCP/IP conversion adapter to
connect the projector, enter the port number.
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Monitor
Password

Description

Monitor

If a Monitor Password has been set for the projector,
be sure to enter the Monitor Password that has been
set. If the correct password is not entered at this time,
it will not be possible to monitor and control the
projector even though it is registered. If using a serial
⇔ TCP/IP conversion adapter to connect the
projector, the Monitor Password security function
cannot be used.
You can enter some kind of memo about the projector.
The details you enter here will be displayed at the
projector properties.
Up to a maximum of 60 bytes can be entered.
Select this when you want monitoring to start.

Registering several projectors to a monitoring group
all at once
Projectors that have been registered can then be registered together into
different groups so that they can be monitored and controlled together.
Furthermore, if you select one of the registered groups as the "Parent
group", monitoring and control operations can be carried out for all
projectors in that "Parent group".
A "Parent group" can be set for other parent groups, so that a hierarchical
group arrangement such as the following can be created.
Branch A

Showroom

Showroom A

No1
No2
No3

Showroom B

4

After entering the details, click [Register] to start the
registration. When the message is displayed, click
[OK].
The icon(s) of the projector(s) you registered will be displayed
in "Grouping view" or "Detail list view".

No5

Lobby
Convention hall

No4

Projector01
Projector02

Branch B

Branch C

Conference room

100
101
102
103

Reception room

Room 1
Room 3

Conference room

201
202

First, create the registration groups, and then register projectors into the
groups that have been created.
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PROCEDURE

1

TIP

Right-click in "Grouping view" and select "New" "Group".
The following window will be displayed.
Make the necessary settings while referring to the table below.
• If "Detail list view" is displayed, select "New" - "Group" from the
"Edit" menu.

You can also carry out this operation by selecting "Group" from
"New" in the "Edit" menu.

2

After entering the details, click [Register] to start the
registration. When the message is displayed, click
[OK].
The icon(s) of the projector(s) you registered will be displayed
in "Grouping view" or "Detail list view".

3

Right-click the projector icon(s) to register to the
group you have created in "Grouping view" or "Detail
list view", and select "Edit".
TIP

Group name

Display icon
Parent group
Monitor

Enter the name of the group(s) to be displayed in
"Grouping view" or "Detail list view".
Up to a maximum of 32 bytes can be entered.
A space cannot be used as the first character.
Select the icon(s) to be displayed in "Grouping view"
or "Detail list view".
This selects the parent group. If no groups have been
created, this cannot be selected.
Select this to monitor all projectors that have been
registered in the group. If this is not selected, the
settings made when the individual projectors were
registered will be used.
It cannot be set when creating a new group.

You can also carry out this operation by selecting "Edit" from the
"Edit" menu.

4

In the "Edit projector" window, select the group name
to use for registering in "Parent group" and then click
[Change].
The status of the group registration will be displayed as an icon
in "Grouping view" or "Detail list view".
TIP

The registration details can also be checked using "Projector list" in
the "View" menu.
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If the projector name or IP address changes after
registration
f For projectors that have been registered manually
PROCEDURE

1

Right-click on a projector icon in "Grouping view" or
"Detail list view" and select "Monitoring disabled".
Then right-click the projector icon again and select
"Edit".
TIP

You can also carry out these operations by using the "Edit" menu.

2

If only the projector name has been changed, click
[Search] in the "Edit projector" window that is
displayed.
If the IP address has been changed, enter the new IP
address in the "IP address" box and then click
[Search]. When the message is displayed, click [OK].

3

When the display returns to the "Edit projector"
window, click [Change].

f For projectors that have been registered using automatic
search
PROCEDURE

1

Delete the projector(s) whose name or IP address has
been changed in "Grouping view" or "Detail list
view". sp.16

2

Carry out automatic search to re-register the
projector(s). sp.8

Registering and deleting projectors for monitoring

Cancelling (deleting) projector registrations
The registrations for projectors can be deleted if they are no longer
required for monitoring or control using EMP Monitor.

PROCEDURE

Right-click the icon for the projector or group that is to be
deleted in "Grouping view" or "Detail list view" and select
"Delete".
When the message is displayed, click [OK].
More than one projector can be selected for deleting by selecting in
"Grouping view" or "Detail list view".
The methods of selecting more than one projector at the same time are as
follow.
• If you select a group icon in "Grouping view", all projectors that have
been registered in that group will be deleted at the same time.
• Hold down the [Ctrl] key on the keyboard while clicking on the desired
icons.
• Use drag and drop to select a range of desired icons.

TIP

You can also carry out this operation by selecting "Delete" from the
"Edit" menu.

16

Monitoring window layout
You can monitor using either of the window layouts below.
• "Grouping view"
This view lets you check the status of group registrations in a hierarchical
diagram.
• "Detail list view"
This view lets you display the status of each projector as a list so that the
projectors can be checked in detail. You can also display specific items as a
list, and sort display items using a specific row as a sort key.
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Monitoring using "Grouping view"
f Meanings of "Grouping view" icons
In "Grouping view", the patterns on the icons indicate the statuses of the
projectors.
.

"Grouping view"

"Grouping view"

"Detail list view"

f How to switch views
"Grouping view" and "Detail list view" are switched as follows.

PROCEDURE

Click the "View" menu, and select "Grouping view" or
"Detail list view".

If the group
icons are round
in shape, it
indicates that
there is another
level below
them. s p.18
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Monitoring window layout
The icon patterns and their meanings are explained below.
Group
No warnings or problems
All projectors in the group are normal.
Warning or problem
A projector in the group has a warning or problem
status.
Notification
A projector requiring immediate attention has been
detected within the group.
Monitoring disabled
The projector is not being monitored. If you rightclick the icon and select "Monitoring enabled", the
projector will be added to the projectors that are
being monitored.
Data being updated
Projector
No warnings or problems*1
Warning or problem

*1 When "Temperature level display group view" is set to "On" at
"Environment setup" in the "Tool" menu, an icon indicating the internal
temperature of the projector will be displayed on top of the projector
icon. The default setting is "Off". As you can get an idea of how the
temperature inside the projector is increasing when the internal
temperature level is displayed, you can make improvements to the
projector's operating environment before a high internal temperature
alarm occurs or the temperature becomes abnormally hot. sp.23
*2 Check the following items.
• Check that the projector's power is turned on.
• Check that the LAN cable is connected.
• Check that "Network Monitoring" is set to "ON" or "Standby Mode"
is set to "Network ON" in the projector's configuration menu.
*3 Check that the projector has been correctly connected to the network.

TIP

The projector information that is generated when a problem is
detected is stored until EMP Monitor is closed. The EMP Monitor
displays will not be updated automatically even if the projector status
returns to normal. Click [Refresh] in the main window to update the
status.

Notification
Monitoring disabled
Data being updated
Network error (monitor password authentication
error)
No Monitor Password was entered when the projector
was registered, or an incorrect Monitor Password was
entered. sp.9, 11, 13
Network error (TCP connection error)*2
Network error (ESC/VP.net communication
error)*3

f Using the icons in "Grouping view"
The following icon operations can be carried out in "Grouping view".
• Expanding and collapsing icons
Each time you double-click a group icon, the icons for the projector that
have been registered in that group are displayed or hidden.
• Moving icons
To change the position of an icon within "Grouping view", simply drag
and drop the icon to be moved.
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Monitoring window layout

Monitoring using "Detail list view"
f Meanings of "Detail list view" icons
The status of registered projectors is displayed as a list in "Detail list view"
regardless of which groups the projectors belong to.

Monitoring disabled
The projector is not being monitored. If you right-click
the icon and select "Monitoring enabled", the projector
will be added to the projectors that are being monitored.
Data being updated
Network error (monitor password authentication
error)
No Monitor Password was entered when the projector
was registered, or an incorrect Monitor Password was
entered. sp.9, 11, 13
Network error (TCP connection error)*2
Network error (ESC/VP.net communication error)*3

The icon patterns and their meanings are explained below.
Type: Displays the projector status.
No warnings or problems*1
Warning or problem
An error has occurred on the projector.
Notification
The projector requires immediate attention.

Group name: When projectors are registered to a group, the name of
the group that the projector belongs to is displayed.
Display name: Shows the display name.
Power: Shows the power on status for the projector.
Power on and normal
Power on and
status
abnormal status
Power off and normal
Power off and
status
abnormal status
Lamp Hours: Shows the lamp operating time for the projector.
Temperature level: The following five icons display the differing
internal temperature status of the projector.
Internal temperature
High-temperature
normal
warning
Internal temperature
Internal temperature
normal
error
High-temperature
warning
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Monitoring window layout

Error information: Shows a notification or warning/problem status
using the following icons.
Clean Air Filter
Lamp Error
Notice
Lamp failure at
Replace Lamp*4
power on
High-temperature
High internal
warning
temperature error
Replace Air Filter

Internal Error

No Air Filter

Fan error

Low Air Flow

Sensor error

Air Flow Sensor Err.

Supply System Error
(Ballast)

Low air flow error

Auto Iris Error

Air filter air flow
sensor error

Other error

Lamp Cover Open
*1 When "Temperature level display group view" is set to "On" at
"Environment setup" in the "Tool" menu, an icon indicating the internal
temperature of the projector will be displayed on top of the projector
icon. The default setting is "Off".
*2 Check the following items.
• Check that the projector's power is turned on.
• Check that the LAN cable is connected.
• Check that "Network Monitoring" is set to "ON" or "Standby Mode"
is set to "Network ON" in the projector's configuration menu.
*3 Check that the projector has been correctly connected to the network.
*4 You can display the "Replace Lamp" warning at any time preset in
"Environment setup" in the "Tool" menu.

TIP

• The projector information that is generated when a problem is
detected is stored until EMP Monitor is closed. The EMP Monitor
displays will not be updated automatically even if the projector status
returns to normal. Click [Refresh] in the main window to update the
status.
• Detectable error information differs with the projector you are using.

f Selecting display items
You can select only the required items to be displayed in "Detail list view".

PROCEDURE

1

Select "Option" from the "View" menu.
The "Option" window will be displayed.
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Monitoring window layout

2
3

Select the check box of the item you want to display.

Click [OK].

Searching for desired icons (Projector list)
The "Projector list" feature is useful for searching in lists when many
groups and projectors are registered and the icon you are looking for is not
displayed on screen.

PROCEDURE

4

When all of the details of the item cannot be displayed
in "Detail list view", drag the boundary line on the
right of the item name so that the view is extended to
the desired width.

f Sorting lists
You can sort detailed lists by using a specific row as a sort key, such as
projector name order or IP address order.

Select "Projector list" from the "View" menu.

With "Projector list", temperature
level icons are not displayed
regardless of the setting of
"Temperature level display group
view" at "Environment setup".

PROCEDURE

Click the item name of the row you want to use as the sort
key.
The "Projector list" lets you check the registration details for groups in a
hierarchical diagram. When you click on an icon, "Grouping view" and
"Detail list view" are scrolled so that the selected icon is displayed in the
window.
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Monitoring using the system tray
The projector statuses are always displayed as icons in the system tray,
even when "Grouping view" or "Detail list view" is not always displayed,
and the statuses can be checked by the icon patterns.
When the configuration menus are set using the following operations, an
icon appears in the system tray and the status can be monitored by means
of the icon's pattern.

PROCEDURE

1

Select "Environment setup" from the "Tool" menu.
The "Environment setup" window will be displayed.

2

Select "Resident in the task tray".

3

Click [OK].

: No problem
: Problem

TIP

• Right-click the icon in the system tray to open a pop-up menu to
select the "Open the main screen" or "Exit".
• If "Register at start up" in the "Environment set up" is selected,
EMP Monitor starts automatically when the computer's power is
turned on. When using EMP Monitor under Windows Vista, you
must have administrator authority in order to use this function.
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Displaying projectors with problem or warning
statuses in a list
You can display a list of only the projectors which have a problem or
warning status.

PROCEDURE

Select "Warning and Error Projector list" from the "View"
menu.
The following "Warning and Error Projector list" window will be
displayed.
If you move the
mouse pointer over
the icon, details of
the error and the
remedy will be
displayed.

If you double-click in
a line, the properties
for that projector will
be displayed.
s p.25

The icon patterns and their meanings are explained below.
Type: Shows the group or projector status. sp.17
Display name: Shows the display name.
Power: Shows the power on status for the projector.
Power on and normal
status

Power on and
abnormal status

Power off and normal
status

Power off and
abnormal status

Lamp Hours: Shows the lamp operating time for the projector.
Source: Shows the input source that has been selected for the projector.
Computer or
Computer1

Video(BNC)

Computer2

DVI or HDMI
(Digital)

BNC

D-Video

S-Video

EasyMP

Video(RCA)
Temperature level: The following five icons display the differing
internal temperature status of the projector.
Internal temperature
normal

High-temperature
warning

Internal temperature
normal

Internal temperature
error

High-temperature
warning
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Error information: Shows the warning or problem status using the
following icons.
Replace Lamp*

Lamp Error

High-temperature
warning

Lamp failure at
power on

Replace Air Filter

High internal
temperature error

No Air Filter

Internal Error

Low Air Flow

Fan error

Air Flow Sensor Err.

Sensor error

Low air flow error

Supply System Error
(Ballast)

Air filter air flow
sensor error

Auto Iris Error

Lamp Cover Open

Other error

*You can display the "Replace Lamp" warning at any time preset in
"Environment setup" in the "Tool" menu.

TIP

Detectable error information differs with the projector you are using.

Checking properties in detail
You can check the properties of groups and projectors in detail.

f Displaying group properties
You can use either of the following methods to display the properties.
• Displaying the properties for all groups in "Grouping view"
Right-click in "Grouping view" and then select "Property".
• Displaying properties for specified groups
Right-click an icon in "Grouping view" and then select "Property".

If you double-click
in a line, the
properties for that
group or projector
will be displayed.
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Displaying and deleting logs

f Displaying projector properties
Right-click on a projector icon in "Grouping view" or "Detail list view"
and select "Property".

In your web browser, you can check a transmission log of content such as
what has been controlled by the EMP Monitor, projector errors. You can
delete logs once you have checked them.

TIP

When "Log output" is set to "On" at "Environment setup" in the
"Tool" menu, transmission logs are stored. The default setting is
"Off".

Displays the
projector firmware
version.

f Displaying logs
PROCEDURE

Select "Log" - "show" from the "View" menu.
The web browser will open and the communication logs up until that
time will be displayed.
f Deleting logs
PROCEDURE

Select "Log" - "Delete" from the "View" menu.
When the confirmation message is displayed, click [OK].
All logs will be deleted and details of EMP Monitor control
operations and details of projector errors from that point onward will
be recorded in a new log.

Using the control functions
Carrying out control using control buttons
Click the icon of a projector to be controlled in "Grouping view" or "Detail
list view", and click a control button to enable control of only that selected
projector.
You can also enable control of all selected projectors by selecting more
than one projector in "Grouping view" or "Detail list view" and clicking a
control button. The methods of selecting more than one projector at the
same time are as follow.
• If you select a group icon in "Grouping view", all projectors that have
been registered in that group and that are set to be monitored can be
controlled at the same time.
• Hold down the [Ctrl] key on the keyboard while clicking on the desired
icons.
• Use drag and drop to select a range of desired icons.
Control buttons

The following table shows the meanings of the control buttons.
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Power On

Turns the projector power on.

Power Off

Turns the projector power off.

Switch source
Computer 1
Switch source
Computer 2
Switch source
BNC
Switch source
S-Video
Switch source
Video(RCA)
Switch source
Video(BNC)
Switch source
DVI, HDMI
Switch source
D-Video
Switch source
EasyMP

Switches the input source to the [Computer1] port
or [Computer] port.
Switches the input source to the [Computer2] port.
Switches the input source to the [BNC] port.
Switches the input source to the [S-Video] port.
Switches the input source to the [Video] port or the
[Video 2] port.
Switches the input source to the [Video1] port.
Switches the input source to the [DVI] port or
[HDMI] port.
Switches the input source to the [D4] port.
Switches to EasyMP or EasyMP.net.
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TIP

• Some connected projectors may not be equipped with all of the
above ports or functions. If you click a button for a port or function
that is not available, nothing will happen.
• You can select objects to be controlled and use the control buttons to
carry out control operations even when the following are being
displayed. sFor details on each display p.23, 24
- Group properties
- Projector properties
- Warning and Error Projector list (Control operations can only be
carried out for projectors with a warning status.)

Carrying out control using a web browser (Web
control)
You can use the computer's web browser to change the configuration menu
settings for projectors.

PROCEDURE

1

Right-click on the icon of a projector to be controlled
in "Grouping view" or "Detail list view" and select
"Web control".

2

The web browser will open and the Web control
window will be displayed.

Web control lets you set the same details as the configuration menu for the
projector. Refer to the Projector's User's Guide for details on the
configuration menu.

TIP

You can select projectors and right-click on them to select "Web
control" even when the following are being displayed.
• Group properties sp.24
• Warning and Error Projector list (Control operations can only be
carried out for projectors with a warning status.) sp.23
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Carrying out control using timer settings
This is useful for carrying out certain control operations such as turning a
projector's power on and off at specified times every day or every week.
Timer settings can be carried out either for a single projector only, or all at
once for all projectors in a group.

PROCEDURE

1

Select "Timer" - "Timer Settings" from the "Tool"
menu.
The following window will be displayed and you can then
check the timer setting status.

The colours in the lines of the list have the following meanings:
: Current day's timer setting
: When some of the projectors in the group have timer setting
enabled and others have it disabled for the current day's timer
setting
: When the current day's timer setting is a disabled setting
: Timer setting for a day other than the current day

The details that can be checked and operations that can be carried out at this
time are given below.
Projectors

Selects a group or projector to check the status of.
When a group is selected, the timer setting statuses for
all projectors in that group are displayed.

Date

Shows the current day in a red box.
Days for which timer settings have been made are shown
in bold.
Click
or
to switch to the calendar for the
previous or next month.

Timers

Shows a list of the timer settings.

[Enabled]
[Disabled]

Switches the timer settings that have been selected from
the timer list between enabled and disabled.

[Add]

Registers new timer settings.

[Edit]

Lets you change the timer settings that have been
selected from the timer list.
If a group has been selected for status checking, the
settings cannot be changed.

[Delete]

Lets you delete timer settings that have been selected
from the timer list.

Using the control functions

f Procedures for new timer settings

2

When you click "Add", the following window is
displayed and the new timer settings are applied.

At "Operation", you can carry out the operations of turning the
power on and off and switching the input sources, similarly for
the control buttons on the main window. If you set the input
source switching, the projector's power will turn on at the timer
start time even if it is not on at the time. Because of this, it is not
necessary to make two separate timer settings for turning the
power on and switching the input source.

3

After completing the timer settings, click [OK].
The timer settings that have been made will be registered and
they can be checked in the displayed timer list.
TIP

You can enable and disable all of the timer settings that have been
registered. Select "Timer" - "Enable" or "Disable" from the "Tool"
menu.
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Setting the mail notification function
The mail notification function can be used to send corresponding notification
messages to a preset e-mail address when a projector that is connected to the
network assumes a certain status, or if it experiences a problem or warning. By
using this function, the operator can be notified of a projector's status or
problems even when the operator is in a different location from the projectors.
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2

The "Set mail notification function" window will be
displayed.
Set the following parameters.

TIP

• Up to three addressees (destinations) can be registered and
messages can be sent to all of them at once.
• If a critical problem develops with a projector which causes it to
suddenly stop working, it may not be possible for the projector to
send a message notifying an operator of the problem.
• If "Standby Mode" is set to "Network ON" or "Network
Monitoring" is set to "ON" in the projector configuration menus,
you can monitor the projector even when it is in standby mode
(when its power is turned off). See your User’s Guide for more
information.
• On some projectors, the mail notification function can be set in the
configuration menu. When notification messages are set to be sent
in the projector's configuration menu, both the settings in the
configuration menu and settings made on EMP Monitor are
functional.
• Detectable status with the mail notification function differs with the
projector you are using.

Mail notification
function

Set to "ON" to use the mail notification function.

SMTP server
IP address

Enter the IP address of the SMTP server.
Up to a maximum of 255 bytes can be entered.
When you change a port number of the SMTP
server, specify this port number. The default value
is "25".
You can enter a valid number from 1 to 65535.

Sender mail
address

PROCEDURE

1

Select "Mail notification function" from the "Tool"
menu.

Enter the sender's e-mail address. Up to a
maximum of 255 bytes can be entered.

Recipient
mail address 1
Recipient
mail address 2
Recipient
mail address 3

Specify the destination addresses for the
notification e-mail. Up to three destinations can be
set. Up to a maximum of 255 bytes can be entered.
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3

Click [Notification event] and check the items for mail
notification in the window that appears.

4

Click [OK].
When the "Set mail notification function" window appears
again, repeat Steps 3 and 4 to set the events to be notified.

5

When the setup is complete, click [OK].

An e-mail notifying the operator of a problem/warning/status is issued
If the projector experiences a problem or enters a status requiring attention,
an e-mail like that shown below is sent to the address specified for
"Recipient mail address".
If there is more than one problem, warning, or status, the corresponding
messages are output to separate lines.
Item
E-mail subject
Body

Details shown
[Display name displayed in "Grouping view" or
"Detail list view"] Projector status notification
<Display name displayed in "Grouping view"
or "Detail list view"> has entered the following
status.
<Problem/warning/status message (Please see
the table below)>

Message

High-temperature
warning

Internal Error
Fan error
Sensor error
Lamp Cover Open

Remedy

See your User’s Guide for more information.

No Air Filter
Low Air Flow
Air Flow Sensor Err.
Clean Air Filter Notice
No signal

No image signals are being received by the
projector. Check the connection status and
check that the power for the connected
equipment is turned on.

Other error
Supply System Error
(Ballast)
Auto Iris Error

Stop using the projector, disconnect the
power cable from the electrical outlet, and
contact Epson.

Network error (TCP
connection error)

Check that the projector's power is turned on
and the LAN cable is connected, and also
check that "Network Monitoring" is set to
"ON" or "Standby Mode" is set to "Network
ON".

Network error (ESC/
VP.net communication
error)

Check that the projector has been correctly
connected to the network.

Network error (monitor
password authentication
error)

Check the projector's Monitor Password.

Lamp Error

Low air flow error
Air filter air flow sensor
error

See your User’s Guide for more information.

Replace Air Filter

Lamp failure at power on
High internal
temperature error

Remedy

Replace Lamp

The details contained in the e-mail message can consist of the following.
Message
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Messages to inform that the projector has recovered from the error or
warning statuses are sent.

Application lock function
You can use the application lock to prevent third parties from operating the
projectors using EMP Monitor and from changing settings without authority.
Opening and closing EMP Monitor and status monitoring can still be carried
out even when the application lock is applied.
In addition, when a password has been set, the password must be entered in
order to cancel the application lock. This ensures that the application lock can
not be easily cancelled, and thus improves system security.

Switching application lock between enabled and
disabled
f Enabling the lock
PROCEDURE

Select "Application lock" from the "Tool" menu.
The application lock will be enabled and no operations will be
possible other than opening and closing EMP Monitor and disabling
the application lock.
f Disabling the lock
PROCEDURE

1

Select "Application unlock" from the "Tool" menu.
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2

The password entry window will be displayed, so
enter the set password and then click [OK].
If no password has been set (default setting), click [OK]
without entering a password. It is recommended that you enter a
password in order to strengthen security.
The application lock will be cancelled and operations can be
carried out as normal.

Setting a password for cancelling application lock
Carry out the following operations while application lock is cancelled.

PROCEDURE

1

Select "Environment setup" from the "Tool" menu.
The "Environment setup" window will be displayed.

2

Select "Change the application lock password".

3

Enter the password in both the "New password" and
"New password (confirm)" boxes and then click [OK].
The password can be up to 16 bytes in length. Single-byte
alphanumeric characters can be used.

Troubleshooting
Projectors cannot be monitored or controlled
Cause
Remedy
Is the projector connected to Connect the network cable correctly.
the network correctly?
See your User’s Guide for more
information.
Has the projector been set
Check the settings for the "Network"
up correctly for connection configuration menu command.
to the network?
See your User’s Guide for more
information.
Has EMP Monitor been
Uninstall EMP Monitor and then re-install
installed on the computer
it.
correctly?
Are all the projectors that
Register the projectors. sp.7
you want to control or
monitor registered?
Is the projector's "Network In order to use EMP Monitor to monitor
Monitoring" or "Standby
and control the projector when it is in
Mode" configuration menu standby mode, the projector's "Network
set to "ON" or "Network
Monitoring" or "Standby Mode"
ON"?
configuration menu must be set to "ON" or
"Network ON".
See your User’s Guide for more
information.
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An e-mail message is not sent when a problem
occurs with a projector
Cause
Remedy
Is the projector connected to Connect the network cable correctly.
the network correctly?
See your User’s Guide for more
information.
Has the projector been set
Check the settings for the "Network"
up correctly for connection configuration menu command.
to the network?
See your User’s Guide for more
information.
Have the SMTP server IP
Check the setting details.
address, port number and
recipient e-mail address all
been set correctly?
Is the projector's "Network To use the mail notification function while
Monitoring" or "Standby
the projector is in standby mode, set
Mode" configuration menu "Network Monitoring" or "Standby Mode"
set to "ON" or "Network
to "ON" or "Network ON" in the
ON"?
projector's configuration menus.
See your User’s Guide for more
information.
Has a critical problem
When the projector has momentarily
developed causing the
stopped working, it cannot send e-mail
projector to momentarily
messages. If the projector cannot be reset
stop working?
even after it has been checked, contact
Epson.
See your User’s Guide for more
information.
Is power being supplied to Check if the power supply to the location
the projector?
where the projector is set up has been
interrupted, or if the circuit breaker for the
electrical outlet that the projector is
connected to has been tripped.
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stored in a retrieval system, or transmitted in any form or by any means,
electronic, mechanical, photocopying, recording, or otherwise, without
the prior written permission of Seiko Epson Corporation. No patent
liability is assumed with respect to the use of the information contained
herein. Neither is any liability assumed for damages resulting from the
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General Notice:
EasyMP and EasyMP.net are trademarks of Seiko Epson Corporation.
Windows, Windows NT, and Windows Vista are trademarks or
registered trademarks of Microsoft Corporation of the United States in
the United States and other countries.
Macintosh is a registered trademark of Apple Inc.
Pentium is a registered trademark of Intel Corporation.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the
purchaser of this product or third parties for damages, losses, costs, or
expenses incurred by purchaser or third parties as a result of: accident,
misuse, or abuse of this product or unauthorised modifications, repairs,
or alterations to this product, or (excluding the U.S.) failure to strictly
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instructions.

Other product names used herein are also for identification purposes
only and may be trademarks of their respective owners. Epson disclaims
any and all rights in those marks.

Seiko Epson Corporation shall not be liable against any damages or
problems arising from the use of any options or any consumable
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